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MANUAL REVISION HISTORY 
 

 Revision 2014.07.15: Initial Firmware Release 3.03.98 
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IMPORTANT SAFETY NOTICE 
 

RAD® TOOLS ARE SAFE AND RELIABLE. NOT FOLLOWING PRECAUTIONS AND 
INSTRUCTIONS OUTLINED HERE CAN RESULT IN INJURY TO THE TOOL, 
OPERATOR AND FELLOW WORKERS. 
 
NEW WORLD TECHNOLOGIES INCORPORATED IS NOT RESPONSIBLE FOR ANY 
SUCH INJURY. 

 
The intended use of the RAD-TV Tool System is for commercial and industrial bolting 

applications.  

Do not operate the RAD-TV Tool System before reading and understanding this user manual 

and noting the Safety Notices displayed on the RAD-TV Tool System and throughout this 

manual. 

Only qualified personnel with training in the safe operation of torque tooling and the RAD-TV 

Tool System should attempt the installation, operation and diagnosis of the RAD-TV Tool 

System. The RAD-TV Tool System is connected to high voltage power and consists of external 

rotating parts. Improper training and use can cause serious or fatal injury. 

Do not disassemble or attempt to repair the RAD-TV Tool System; doing so will void warranty.  

If breakdown, malfunction, or damage occurs and the RAD-TV Tool System fails to operate 

correctly, contact New World Technologies Inc. Technical Support (refer to Section 8.0 – 

Contact Us).  

The RAD-TV Tool System should only be used if environmental storage and operation 

specifications have been met. Refer to Section 1.2.3 – Environmental Specifications. 

Electrical Shock can cause serious or fatal injury. Do not apply power to the RAD-TV Tool 

System without verifying the Earth Ground. Ensure the RAD-TV Tool System is properly Earth 

Grounded before turning on the Power Switch. Do not touch any power devices or electrical 

connections or remove the RAD-TV Controller Top Plate before ensuring the Power Switch is 

in the Off Position and no high voltage is present.  

While operating the RAD-TV Tool System, always wear safety goggles and keep all body parts 

clear of moving parts and the Reaction Arm Contact Point.  

Always support the RAD-TV Tool Handle while the RAD-TV Tool System is in use. This will 

prevent unexpected release in the event of fastener or component failure. 

Never exceed the Maximum Torque of the RAD-TV Tool System. Failure to comply will result 

in void warranty. 

The RAD-TV Tool System has been calibrated by a qualified Calibration Technician; calibration 

must be done by a qualified Calibration Technician. Improper calibration can cause damage 

to the tool and joint. 
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IMPORTANT BATTERY SAFETY NOTICE 
WARNING! Do not operate the tool or charge the batteries before reading the safety instructions and 

warnings detailed in this manual. If breakdown, malfunction, or damage occurs, DO NOT 

attempt to repair; contact New World Technologies Inc. or your local distributor immediately. 

 Lithium Polymer batteries are volatile. Failure to read and follow these instructions 
may result in fire, personal injury and/or damage to property if charged or used 
improperly. 

 New World Technologies Inc., its distributors and retailers assume no liability for 
failures in compliance with these warnings and safety guidelines. 

 By purchasing this tool system and battery, the buyer assumes all risks associated 
with this product.  If you do not agree with these conditions, please return the tool 
and accessories immediately and before use. 
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1.0 General Information 
1.1 System Components 

The RAD-TV Tool System is shipped from New World Technologies Inc. with the following 

components: 

- RAD-TV Tool (Figure 1.1-1) 

- Standard Reaction Arm and Snap Ring (Figure 1.1-2) 

- Tool Regulator Cage (Figure 1.1-3) 

- Calibration Certificate 

- User Manual 

- Computer Based Training CD (CBT) (Figure 1.1-4) 

- USB Comms Cable and USB Charger 

- USB Stick Containing RT Data Logger Software (only available upon request) 

 

 

 
 

Figure 1.1-1 RAD-TV Tool           Figure 1.1-2 Reaction Arm 

 

 

 

 

 

 

Figure 1.1-3 Regulator                        Figure 1.1-4 CBT 

Note: Some distributors may ship additional parts along with the RAD-TV Tool System 

1.2 Specifications 

1.2.1 Imperial Specifications 
Tool Model Torque Range (Foot-Pounds) Noise 

Level 
Vibration 

7GX-R TV 300 – 700 80 db <2.5 m/s2 

10GX TV 200 – 1000 80 db <2.5 m/s2 

34GX TV 1000 – 3400 85 db <2.5 m/s2 

Table 1: Imperial Specifications 

1.2.2 Metric Specifications 
Tool Model Torque Range (Newton-Meters) Noise 

Level 
Vibration 

10GX-R TV 400 – 950 80 db <2.5 m/s2 

14GX TV 275 – 1350 80 db <2.5 m/s2 

46GX TV 1400 – 4600 85 db <2.5 m/s2 

Table 2: Metric Specifications 
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1.2.3 Charging Specifications 
 Units 240 mAh 

Charge Time Hours Approx. 1 

Storage Time (Must be fully Charged) Months 3-4 

Table 3: Charging Specifications 

1.2.4 Environmental Specifications 

CAUTION!    Only operate the RAD-TV Tool System if the following environmental storage and operation 

  specifications have been met. 
 All Models 

Ambient Operating Temperature Range °C °F 

Pneumatic Only   

Operating Temperature -20 to 40 -4 to 104 

Pneumatic with Electronics   

Optimum Battery Life 5 to 35 41 to 95 

Absolute Maximum 1 to 60 34 to 140 

Ambient Charging Temperature Range °C °F 

Temperature at Charging 0 to 45 32 to 113 

Storage Temperature Range °C °F 

Optimum Battery Life -20 to 45 -4 to 113 

Storage More than 3 Months 0 to 30 32 to 86 

Humidity 10% to 90% non-condensing 

Table 4: Environmental Specifications 

2.0 Battery Usage and Charging 
This section provides instructions for safe usage and charging of the RAD-TV internal LiPo 

battery. 

WARNING!    Do not operate the tool or charge the batteries before reading the safety instructions and 

warnings detailed in this manual. If breakdown, malfunction or damage occurs, DO  NOT 

attempt to repair. Contact New World Technologies Inc. or your Local Distributor immediately. 

WARNING!    Lithium Polymer (LiPo) batteries are volatile. Failure to read and follow these instructions may 

result in fire, personal injury and/or damage to property if charged or used improperly. 

 

2.1 General Safety Warnings and Guidelines 
The RAD-TV is assembled, calibrated and shipped with a rechargeable Lithium Polymer (LiPo) 

battery 

1. Batteries are NOT fully charged as you receive them. They may contain 

approximately 50% of a full charge. 

2. Use the New World Technologies Inc. supplied USB Charger only. Do not use 

any other Lithium Polymer or NiCd or NiMh charger - Failure to comply may 

cause a fire, which may result in personal injury and/or property damage. 

3. Never charge the tool unattended. When the LiPo batteries are charging, they 

should always remain under constant observation so you can better react to 

any potential problems that may occur. 

4. Charge in an isolated area, away from flammable materials. 

5. Let the RAD-TV battery cool down or warm up to recommended ambient 

temperature before charging. 

6. If there is any sign of damage to the charger or charging cable, do not attempt 

to charge the tool/battery. Unplug the charger immediately. 

7. If there is any sign of damage to the tool housing or to the battery pack, do not 

attempt to charge  

8. If there is any sign of damage to the battery pack or the battery pack is leaking, 

do not attempt to charge or make direct contact.  If battery fluid comes into 

direct contact with skin or eyes, flush immediately with fresh, clean water and 

contact a physician. 
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2.2 Battery Charging and Storage 
Battery life and charge capacity will be greatly extended by following the optimal operating, 

charging and storage temperature ranges stated in Section 1.2 - Specifications. 

Depending on age, ambient operating conditions and care, a fully charged battery should 

have a stand-by life of 1-2 weeks. 

Depending on the above mentioned factors, and in addition to run-down time, a fully charged 

battery should have an operation usage of several thousand bolts. 

2.3 Battery Removal and Replacement 
If the tool and battery guidelines are followed, the battery life should exceed the normal re-

calibration interval of the tool.  As a preventative measure the battery should be replaced by 

New World Technologies or an Authorized Service Centre at the desired re-calibration interval 

and only be replaced with an NWT approved battery. 

The user should not replace the battery at any time without NWT approval. 

3.0 Tool System 
The following sections give a visual and functional description of the Tool Handle and 

Regulator Cage. 

3.1 Tool Handle Description 
 

 

 

 

 

 

 

Spline or Serpentine 

Output Square Drive 

Forward and 

Reverse Switch 

Trigger 

Air Inlet 

Main Button 

LED 

Bluetooth Reset Button 

Micro USB Port 



   RAD-TV USER MANUAL 

New World Technologies  Page  •  9 
V2014.07.15 

3.2 Regulator Cage Description 

 

 

4.0 General Operating Instructions 
WARNING!    Do not operate the tool before reading these instructions. If breakdown, malfunction or 

damage occurs, do not attempt to repair; contact New World Technologies Inc. 
immediately. 

RAD® Pneumatic Torque Wrenches are reversible, non-impacting, torque controlled 
tightening tools and must always be operated with the following: 

- Clean dry air supply with a minimum flow of 100psi and 30cfm and 1/2" airline. 
- Regulator Cage Assembly with lubricator and regulator. 
- Impact Sockets 
- Proper Reaction Arm 

WARNING!   Where the intended usage is not with threaded fasteners, the safety of operation must be 

evaluated and appropriate precautions must be taken. New World Technologies Inc. will be 
pleased to advise you as to what those may be. 

WARNING!   These tools contain alloy components which may cause a hazard in certain explosive 

environments. Please call New World Technologies Inc. for further information. 

4.1 Tool Assembly 
1. Blow out hoses before connecting. 
2. Connect the wrench Air Inlet to the Outlet side of the Cage Assembly, observing 

airflow direction. 
3. Connect air supply to Inlet side of the Cage Assembly using a minimum hose 

size of ½ inch. 
4. Check oil level in Lubricator and fill to correct level. 
5. Attach Reaction Arm to Spline or Serpentine adjacent to the Output Drive of the 

wrench and secure with Circlip. 

WARNING!   To avoid hazard from whipping air hoses, make all connections to the tool before turning on 

the air supply. 
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4.2 Reaction Arm 
WARNING! Always keep body parts clear of the Reaction Arm when the RAD-TV Tool System is in 

use. Serious injury could occur.  

CAUTION! Ensure the Reaction Arm has a solid contact point before operating the RAD-TV Tool 

                                            System.  

4.2.1 Installing the Reaction Arm  

Ensure the Reaction Arm and Snap Ring are installed securely to hold the Reaction Arm in 
place.  Make sure the Reaction Arm is in contact with a solid Reaction Point before you operate 

the tool.  Keep your body parts clear of the Reaction Arm when the tool is in operation.  

When the tool is in operation the Reaction Arm rotates in the opposite direction to the Output 
Square Drive and must be allowed to rest squarely against a solid object or surface adjacent 
to the bolt to be tightened (Figure 4.2.1-1). 

 
Figure 4.2.1-1:  Reaction Point 

CAUTION! Keep your hand and body parts clear of the Reaction Arm and barrel when the tool is in 

operation. 

 
Figure 4.2.1-2: Incorrect Placement of Hand/Body Parts During Operation 

4.2.2 Reaction Arm Height 

Ensure the height of the socket is even with the height of the Reaction Arm as seen below in 

Figure 4.2.2-1.  The height of the socket cannot be shorter or higher than the height of the 

Reaction Arm as seen below in Figure 4.2.2-2.  
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CORRECT: The Reaction Arm and socket are even height. 

 
Figure 4.2.2-1: Correct Height 

INCORRECT: The leg of the Reaction Arm is too short on the left side, and too long on the right side. 

 
Figure 4.2.2-2: Incorrect Height 

IMPROPER REACTION WILL VOID WARRANTY AND CAN CAUSE PREMATURE TOOL FAILURE. 

4.2.3 Reaction Arm Foot 

Ensure the foot of the Reaction Arm aligns with the length of the nut as seen in Figure 4.2.3-

1. The length of the foot cannot be shorter or longer than the nut as seen in Figure 4.2.3-2. 

CORRECT: The foot of the Reaction Arm aligns with the length of the nut. 

 
Figure 4.2.3-1: Correct Length 
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INCORRECT: The foot of the Reaction Arm is too short on the left side, and too long on the right side. 

 
Figure 4.2.3-2: Incorrect Length 

Please contact New World Technologies Inc or your local RAD Authorized Distributor for 

custom Reaction Arms. 

4.2.4 Reaction Points 

Ensure the Reaction Arm reacts off the middle of the foot as seen in Figure 4.2.4-1. Do not 

react off the heel of the reaction foot as seen in Figure 4.2.4-2. 

CORRECT: Reaction Arm is reacting off the middle of the Reaction Arm’s foot. 

 
Figure 4.2.4-1: Correct Reaction Point 

INCORRECT: Reaction Arm is reacting off the heel of the Reaction Arm.  This can cause premature tool failure. 

 
Figure 4.2.4-2: Incorrect Reaction Point 

4.3 Turning on the RAD-TV 
To turn on the RAD-TV, press the button at the end of the gearbox. When on, the LED should 

blink blue. When a bolt is torqued, the LED will hold blue for a few seconds then continue 

blinking blue. 

When in Pass/Fail Mode, the LED will single blink green for a pass, single blink red for an 

undertorque, and double blink red for an overtorque. For more information on Pass/Fail Mode 

refer to Section 6.2 – Operating Modes. 
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4.4 Setting Torque for Bolt Tightening 
Every RAD® torque wrench is supplied with a Torque Chart which relates torque output to air 
pressure. Set the torque as follows: 

1. Ensure the Forward/Reverse is set to "Forward". 
2. Establish the air pressure required using the Torque Chart provided with the 

tool. 
3. Adjust the regulator until the correct pressure is shown on the gauge. 

 

CAUTION!  Do not exceed maximum air pressure setting on the torque chart. 

IMPORTANT!    The wrench must be free running while adjusting the air pressure to give the correct setting. 

4.5 Setting Torque for Bolt Loosening 
1. Ensure the Forward/Reverse switch is set to "Reverse". 
2. Establish maximum air pressure from the Torque Chart and set the air pressure 

the same as with tightening. 

 

WARNING!    Exceeding the maximum air pressure will overload the wrench and may cause 

serious damage. 

 

4.6 Operating the Wrench 
1. Fit the wrench with the correct size impact socket to suit the bolt to be 

tightened. 
2. Check the Forward/Reverse switch is set correctly. 
3. Rotate the handle to a convenient position relative to the Reaction Arm 
4. Fit the tool onto the bolt to be tightened with the Reaction Arm adjacent to the 

Reaction Point. (see Figure 4.1.1-1) 
5. Squeeze the Trigger partially to bring the Reaction Arm into contact with the 

Reaction Point. 

CAUTION!    When in use this tool must be supported at all times in order to prevent unexpected release 

in the event of a fastener or component failure. 

6. Fully depress the Trigger and keep fully depressed until the wrench stalls. If the 
Trigger is released before the wrench stalls, full torque will not be applied to 
the bolt. 

7. Release the Trigger and remove the tool from the bolt. 

5.0 Data Log PC Operations 
The PC Interface is used to interact with the Remote Audit System. Once connected to the 

Remote Audit System the operator is able to download Data Logs, view tool details, configure 

the specifications of the tool and calibrate the Remote Audit System. Figure 5.0-1 shows the 

main display screen. For more detailed information on the Data Logger, refer to the RT Data 

Logger Manual located under the “Help” dropdown menu in the Data Logger (Figure 5.0-2). 
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Figure 5.0-1: Main Display Screen 

 

 
Figure 5.0-2: The Help Dropdown Menu 

5.1 Software Installation & PC Requirements  
The RT Data Logger Software is compatible with Window XP, Windows Vista, Windows 7 and 

Windows 8 operating systems. 

Note: The “New Customers” download package is for customers with a Windows 8 computer or for those 

that do not have an existing database (compatible with Windows XP, Windows Vista, Windows 7 and 

Windows 8). 

Note: The “Existing Customers” download package is for customers who have an existing database that 

is still in use (compatible with Windows XP, Windows Vista and Windows 7). 

The RT Data Logger Software can be downloaded from www.radtorque.com. 

Choose either the “New Customers” or the “Existing Customers” download package for the 

Data Logger Software, then a “Hardware Driver” download package for the drivers necessary 

for operations. 

After the download is complete find and click on the “Setup.exe” in the Data Logger download 

package and the “.exe” in the Drivers download package then follow the installation 

instructions. 

Note: If a physical copy is needed, request a CD copy or a memory stick copy from your Authorized RAD 

Distributor or New World Technologies Inc. Refer to Section 8.0 – Contact Us.  

5.2 Connecting the RAD-TV to a PC 
WARNING! Refer to Section 2 – Battery Usage and Charging, and follow all instructions and warnings 

prior to connecting the USB Charger/Comms Cable.  Failure to do so may cause the battery 
to combust and may cause serious or fatal injury. 

The RAD-TV can be connected to a PC through Bluetooth or USB connection for RAD-TV 

Configuration and Data Log downloads.  
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5.2.1 Connecting with Bluetooth 

To connect through Bluetooth: 

1. Turn on the RAD-TV, refer to Section 4.2- Turning on the RAD-TV, for 
information on how to do this. Then press the button again to turn the Bluetooth 
on. When Bluetooth is on the LED will double blink blue. 

2. To connect the RAD-TV to the PC follow the below steps: 
Note: It is recommended that a Bluetooth Dongle is used when connecting the RAD-TV to a PC. The 

Bluetooth Dongle has a range that goes further than the range of a computer with integrated Bluetooth. 

a. Right click the “Bluetooth Devices” icon in the bottom right of the 
screen. 

b. Click “Add a Bluetooth Device”. 
c. Click the serial number of the RAD-TV that you want connected. 
d. Enter the correct pairing code. 

Note: The default pairing code is “1111”. Refer to Section 5.6 – Changing the Bluetooth Pin, for 

information on how to change the pairing code. 

3. Open the RT Data Logger Software. 

4. Select “Scan All Active Transducers” from the bottom of the screen (Figure 
5.2.1-1). The RAD-TV should now be connected to the PC. Proceed with 
configuration (Section 6.0 – RAD-TV Configurations) or data download (Section 
– 5.3 Downloading all Data Logs). 

 
Figure 5.2.1-1: Scan All Active Transducers                                                        

5.2.2 Connecting with the USB Cable 

To connect through a USB connection: 

1. Turn on the RAD-TV by pressing the button at the end of the gearbox. 

2. Plug the USB Charger/Comms Cable into the PC via the USB connector. 

3. Carefully remove the rubber dust cover from the RAD-TV Comms Port using 

tweezers, needle nose pliers or a similar tool. 

4. Plug the USB Charger Comms Cable into the RAD-TV via the mini USB connector. 

5. Start the RT Data Logger Software on your PC. 

6. Within the RT Data Logger Software, select “Select Transducer Manually” from 

the “Transducer” dropdown menu, then select “Com Port” (Figure 5.2.2-1). 

7. Select the Com Port that the RAD-TV is connected to. 

8. Proceed with configuration (Section 6.0 – RAD-TV Configurations) and data 

download (Section 5.3 – Downloading all Data Logs). 

Figure 5.2.2-1: Com Port Selection 

5.3 Downloading all Data Logs 
Note: The RAD-TV holds 360 Logs. 

Using the RT Data Logger Software, the operator is able to download the stored Data Log 

from the RAD-TV to the PC. 

1. Select “Download Logs” from the “Tool” dropdown menu or press the 

“Download Logs” button on the main screen (Figure 5.3-1).  

2. The PC program will download all the data from the device. 
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3. You will be prompted to add descriptions of the tool and the Data Logs once 

the Log has been downloaded. These descriptions can be anything to help you 

identify the data.  
Note: These descriptions cannot be changed at a later date. 

 
Figure 5.3-1: Download Logs Button 

5.4 Deleting (Closing) Data Logs 
Closing Data Logs allows the operator to permanently remove the log from the RAD-TV. This 

information will remain on the PC. The title of the Closed Log will be automatically modified 

to represent the date it was closed.  

To close a Data Log: 

1. Select the log you would like to close. 

2. Select “Close Logs” from the “Tool” dropdown menu or press the “Close 
Logs” button on the bottom right of the main screen (Figure 5.4-1). 

 
Figure 5.4-1: Close Logs Button 

3. The name of the log file will automatically change to “Closed” with the date 
and time at which it was closed (Figure 5.4-2). 

 
Figure 5.4-1: A Closed Log                                                       

5.5 Printing Data Log Reports 
This feature allows to user to print a Data Log Report for a selected Data Log. 

To print a Data Log Report: 

1. Select the Data Log that you want to print. 

2. In the “File” dropdown menu, press “Print Data Log Report” (Figure 5.5-1). 

 
Figure 5.5-1: Print Data Log Report Button 

3. The Data Log Report will then be printed to the default printer that is set up on 
your PC. 
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5.6 Generating Data Log Reports 
This feature allows the user to generate a Data Log Report for a selected Data Log. 

To generate a Data Log Report: 

1. Select the Data Log that you want to generate a report for. 

2. In the “File” dropdown menu, press “Generate Data Log Report” (Figure 5.6-
1). 

 
Figure 5.6-1: Generate Report Button 

3. The generated report will then be displayed (Figure 5.6-2). 

 
Figure 5.6-2: Generated Data Log Report 

4. From the generated report window, the report can be printed or saved as a 
different file type. 

5.7 Exporting Data 
Exporting data allows the user to save the Data Logs to another location and also allows the 

user to print the Data Logs. 

1. In the “File” dropdown menu press “Export to cvs file” (Figure 5.7-1). 

 
Figure 5.7-1: Export Button 
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2. A prompt window will be displayed asking to export all Data Logs or just the 

currently selected Data Log (Figure 5.7-2). If “Yes” is selected, all Data Logs 
will be exported. If “No” is selected, only the currently selected Data Log will 
be exported. If “Cancel” is selected, no Data Logs will be exported. 

 
Figure 5.7-2: Export Dialog box 

3. If “Yes” or “No” was selected, a window will be displayed asking for a location 
to save the file (Figure 5.7-3).  

 
Figure 5.7-3: Saving the Data Log 

4. The file can now be opened to view and can now be printed from the PC. 

5.8 Changing the Bluetooth Pin 
Changing the Bluetooth Pin allows the user to change the pairing code of the RAD-TV. 

To change the Bluetooth Pin: 

1. Connect the RAD-TV to the PC. Refer to Section 5.2 – Connecting the RAD-TV 
to a PC, for more information on this procedure. 

2. In the “Tool” dropdown menu, press “Bluetooth Pin” (Figure 5.8-1). 



   RAD-TV USER MANUAL 

New World Technologies  Page  •  19 
V2014.07.15 

 
Figure 5.8-1: Bluetooth Pin Button 

3. A dialog box will be displayed asking for the old Pin and a new Pin (Figure 5.8-
2).             

 

Figure 5.8-2: Changing the Bluetooth Pin 

Note: The new Pin must be 4 digits long. 

4. After the new Pin is entered, reset the RAD-TV and reconnect it to the PC using 
the new pairing code. 

6.0 RAD-TV Configurations 
Prior to each deployment, the user should verify the RAD-TV is configured as desired.  Access 

to a PC or Laptop running the RT Data Logger software is required. 

Configuration includes date/time clock, measurement units, operating modes, and if enabled, 

targets and pass/fail indication tolerance.  

RT Data Logger Software is available for download from www.radtorque.com 

See Section 5.1 – Software Installation & PC Requirements, for more information on installing 

the RT Data Logger Software. 

See Section 5.2 – Connecting the RAD-TV to a PC, for more information on connecting the 

RAD-TV to the PC. 
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6.1 Tool Setup 

Under the Tool dropdown menu located in the “RT Data Logger Software” select “Setup” 

(Figure 6.1-1). 

 
Figure 6.1-1: The Setup Button 

After “Setup” is selected, the Tool Setup Menu will be displayed (Figure 6.1-2). 

 
Figure 6.1-2: Tool Setup Menu 

Once all the desired changes have been made, press “Update”. 

6.1.1 Date/Time 

The date and time can be set manually or press “Use Current Time” to use the PC date/clock 

time. 

6.1.2 Measurement Units 

Select the desired units from the “Units” dropdown menu (Figure 6.1.2-1). The possible 

choices are “FTLB”, “INOZ”, “INLB”, and “Nm”. 
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Figure 6.1.2-1: Units Dropdown Menu 

6.1.3 Target Tolerance 

In the Tolerance % box, enter the tolerance from the target desired to indicate a pass or a 

fail. 

Note: Operation Mode – “Target Pass/Fail Enable” must be selected for the tolerance parameter to 

be effective. Refer to Section 6.2 – Operating Modes for more information on this option. 

6.1.4 Tool Uptime 

This is the amount of time (in minutes) before the tool goes to sleep. By default this time is 

set to 10 minutes. 

6.1.5 Bluetooth Uptime 

This is the amount of time (in minutes) before the Bluetooth turns off. By default this time is 

set to 9 minutes. 

6.1.6 Set Points 
In the Set Points box (Figure 6.1.6-1), enter the desired target that will be selectable by the 

user. To select a Target, click on the desired Target. To add a new Target, press the “Star” 

in the bottom left corner (Figure 6.1.6-1). To change a current Target, double click the Target 

that needs to be changed and enter the new Target. 

Note: The currently selected Target will have an arrow beside it (Figure 6.1.6-1). 

Note: Operation Mode – “Target Pass/Fail Enable” must be selected for the Target parameter to be 

effective. Refer to Section 6.2 – Operating Modes for more information on this option. 

 
Figure 6.1.6-1: Set Points Box                                

6.2 Operating Modes 
Note: The RAD-TV must be connected to the Data Logger for these operations to be enabled. Refer to 

Section 5.2 – Connecting the RAD-TV to a PC, for more information on how to connect the tool. 

Under the “Tool” dropdown menu located in the “RT Data Logger Software” select 

“Setup”, then select the desired Operating Modes (Figure 6.2-1). 
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Figure 6.2-1: Tool Setup Menu 

Operating Modes: 

6.2.1 Target Pass/Fail Enable: 

When the “Target Pass/Fail Enable” is disabled, the RAD-TV will be in “Audit” mode and 

will measure and record the torque according to the measurement mode selected. 

Once “Target Pass/Fail Enable” is enabled, press “Update”. The RAD-TV may now be 

disconnected from the PC and used with Pass/Fail Mode. 

When the “Target Pass/Fail Enable” is enabled, PASS/FAIL indication via the LED will be 

updated based on the desired tolerance (Section 6.1.3 – Target Tolerance) within target 

(Section 6.1.6 – Set Points).  

When the torque is passed, the LED will single blink green. When the torque is failed, the 

LED will blink red. If the bolt is under torqued, the LED will single blink red. If the bolt is over 

torqued, the LED will double blink red. 

6.2.2 Large Font: 

Not available on the RAD-TV. 

6.2.3 Redo Screen:   

Not Available on the RAD-TV. 

6.2.4 Cal Mode: 

When Cal Mode is enabled, raw data values that come from the strain gauges are stored in 

the logs. These numbers are not in any torque units. 

 

6.2.5 Real Time Graphs: 
Note: The RAD-TV must be connected to the Data Logger during the torque cycle for Real Time Graph 

Mode to work. Refer to Section 5.2 – Connecting the RAD-TV to a PC, for more information on how to 

connect the tool. 

When Real Time Graphs is enabled, the user can view a live graph of the torque cycle on the 

“RT Data Logger Software”. To view the live graph, go to the “Tool” dropdown menu and 

press “Graph Torque” (Figure 6.2.5-1). 

1 

 
2 

 3 

 
4 

 
5 
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Figure 6.2.5-1: Graph Torque Button 

The Torque Vs Time Graph will then be displayed on the screen (Figure 6.2.5-2). 

 
Figure 6.2.5-2: Torque Vs Time Graph 

When a pull is done with the RAD-TV, a live graph will be created on the Torque Vs Time 

screen (Figure 6.2.5-3). 

 
Figure 6.2.5-4: Live Graph        
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7.0 Troubleshooting 
WARNING! Disassembling or attempting repair will void warranty. 

 Electrical Shock can cause serious or fatal injury.  Do not remove the battery cover or attempt 
to repair the device or replace the battery. Do not touch any exposed power device, electrical 
connections or cable. 

If breakdown, malfunction or error occurs, contact New World Technologies Inc. Technical 
Support (refer to Section 8.0 – Contact Us). 

The following flowchart can help with troubleshooting the RAD-TV.  
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8.0 Contact Us 
 

New World Technologies Inc. 
30580 Progressive Way 

Abbotsford, BC, V2T 6Z2 
Canada 

 

 

 

 

 

 

 

 

Toll Free: 1-800-983-0044 
Fax: 604-852-0269 

Email: info@radtorque.com 
Web: www.eradtorque.com 

New World Technologies Inc. Technical Support: 1-800-983-0044 
(Ext. 227) 

Email: eradsupport@radtorque.com 

 

 

 


